panoramlc”

COMPUTER SETUP INSTRUCTIONS

Whether you are upgrading or replacing your current dedicated panoramic x-ray machine computer; please follow these steps to
ensure a successful transition to your new computer.

Panoramic Technical Support can be reached at 800-654-2027 / support@pancorp.com for any questions.

PANORAMIC DENTAL IMAGING

Computer & Software Setup Instructions

for a computer with Windows 10 Professional 64-bit

Used with X-ray Machines:

PC-1000

PC-4000 Envision P (Pan only) or
Digital Upgrade Encompass Pan or Pan/Ceph

1st Generation (sn# K000028-K000366) Envision C1 (Pan/Ceph)
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Pre-Setup - from the existing computer
Backup Calibration Files
Identify capture card
Computer Information

Setup - on the new computer
Verify Computer Operating System & Type
Disable Sleep, Hibernate, & Fast Startup
Install Software - Panoramic Dental Imaging
Install or Configure Drivers for capture card
Verify or Configure Software Settings— Panoramic Dental Imaging
Restore Calibration Files

Adjust Image Appearance

On the existing computer, backup the calib & datastor hidden folders:

Required -- C:\ProgramData\Ajat\panoramic\calib\
Optional -- C:\ProgramData\Ajat\panoramic\datastor\
Note: The datastor folder is used to reload recent images taken. It is not used as a long-term backup.

Alternatively these folder can be accessed from the software under the Tools Menu. If calibration files are not available
on the existing computer due to a computer issue/crash, then a new set of calibrations can be created by having an X-
ray Technician visit your office. Call Support for details.

Image Tools Window Help
Histogi Settings ... |

Dataset tools
DICOM ...

Maintenance ¥ Mechanical alignment ...
Send error report .. Calibration ...

Language N Diagnastics L

Files and Folders > Open log file
Open Log folder
Open Calibration folder



Qo w 2 3 A : )

Type Intel CT Desktop Adaptor
Expansion PCI Express x1 or x16
Slot
Size Full or Half Height
- call to order different size bracket
Compatible Windows 7 Pro 32/64 bit
Operating Windows 10 Pro 32-bit NOT SUPPORTED
Systems Windows 10 Pro 64-bit Only
Used with PC-1000 Digital
Pano PC-4000
Machines Encompass HF-100 Eagle (2D & 3D CBCT)
Envision P / Envision C1
Processor (Intel Brand Required) i5 6th Generation or later
RAM 8 GB
Hard Drive 500+ GB or greater,

7200 RPM or faster

One Available Expansion slot

PCI-Express x16
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From the Start Menu, type “This PC” and click on Properties

Al Apps Documents  Settings Web  More v Feedback
Best match
[y ThisPC
= pop e
Search the web.
This PC

P This PC - See web results > App
Settings (6)

7 Open

<= Pin to Start

= Pin to taskbar

C& Manage

= Map network drive

52 Disconnect network drive

B properties

+
ﬂ L This PC O

o

An Example is shown. Windows 10 Professional, 64-bit Operating System

Control Panel Home . . .
View basic information about your computer

& Device Manager Windows edition

® Remote seitings I Windows 10 Pro for Workstations I

) System protection © 2019 Microsoft Corporation. All rights reserved, .. WI n d OWS 1 0

) Advanced system settings

Systermn
Manufacturer: Dell
Model: Latitude 5480
Processor Intel(R) Core(TM] i3-6440HC CPU @ 2.60GHz 2.60 GHz
Installed memory (RAM): 16,0 GB (15.6 GB usable) m
I Systemn type: 64-bit Operating Systern, x64-based processor I Eﬂ-’;

Pen and Touch: Mo Pen or Touch Input is available for this Display
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a. If PCis windows 10, open the start menu and type “power” click on the “Power and sleep settings”.

I\ Power & sleep settings
System settings

b. On the right side of the window, under Related settings, click “Additional power settings”.
c. On the left side of the window, click “Choose what the power buttons do”.
Near the top of the window click “Change settings that are currently unavailable”.

3 System Settings

&« S @ # Contrel Panel # Hardware and Sound ¢ Power Options »  System Settings w| & Search Contr

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the SEttiF,\gs on this
page apply toall of vour power plans,

® Change settings that are currently unavailable +—_

Power button settings

e. Uncheck the boxes.
E System Settings

« v A E » Control Panel » Hardware and Sound » Power Options » System Settings v | D Search Con

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans.

Power button settings

@ When | press the power button: | Shut down ~

Shutdown settings

|:| Turn on fast startup (recommended)
This helps start your PC faster after shutdown. Restart isn't affected. Learn More

Show in Power menu.
[] Hibernate

Show in Power menu.

Lock

Show in account picture menu.




Note: If previously installed, or if this is an upgrade from Windows 7, make sure to uninstall any previous versions of the
program, listed as Panoramic Dental Imaging, or formerly called Ajat Dental Imaging.

Download and Run the software Installation. Panoramic Dental Imaging 9.1.2.7600.exe

Use the Default selections by clicking the Next buttons. Here are the screens to show the prompts.

ﬁ! Setup - Panoramic Dental Imaging had —

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue.

Full installation with hardware support ~

Cancel

ﬁ! Setup - Panoramic Dental Imaging had - X

Ready to Install
Setup is now ready to begin installing Panoramic Dental Imaging on your
computer,

Click Install to continue with the installation.

< Back Install Cancel

i -
Installing
Please wait while Setup installs Panoramic Dental Imaging on your computer,

Finishing installation. ..

Setup *

Please, install SMAP GigE driver protocol in network adapter
settings and restart computer before using the software,

ﬁ! Setup - Panoramic Dental Imaging had —

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Panoramic
Dental Imaging, then dick Mext,

Additional icons:

File assodations:

Associate extension .OTZ

< Back Cancel

ﬁ! Setup - Panoramic Dental Imaging had —

Installing
Flease wait while Setup installs Panoramic Dental Imaging on your computer,

Extracting files...
C:'\Program Files (x&5)\Panoramic\priestapp.exe

. Cancel 4

ﬁ! Setup - Panoramic Dental Imaging had —
Completing the Panoramic Dental
Imaging Setup Wizard

Setup has finished installing Panoramic Dental Imaging on your
computer. The application may be launched by selecting the
installed shortcuts,

Click Finish to exit Setup.



http://www.pancorp.com/software/files/PANCORP_DENTAL_IMAGING_9.1.2.7600.exe
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a. Right-click on the network icon E next to the clock on your taskbar and click “open Network & internet
settings”.

Troubleshoot problems

Open Network & Internet settings

11/8/2019

b. Click on “change adapter options”.

< Settings X
it Home Status
| Find a setting yel Network status

Network & Internet g @ @

I B Status Local Area Connection
T Ethernet You're connected to the Internet
If you have a limited data plan, you can make this network a
2 Dialup metered connection or change other properties.
Change connection properties
% VPN
Show available networks
5 Data usage
B Poxy Change your network settings

(&) Change adapter options
View netvark adapters and change congction settings,

% Sharing options
For the networks you connect to, decide what you want to share.

A\, Network troubleshooter
Diagnose and fix network problems.

View your network properties
Windows Firewall

Network and Sharing Center

c. Right-click on the “Intel gigabit CT desktop adapter” and chose “properties”.

- Pano I P
L. | "= _ Enabled
—omi®  Enabled ,

. W Intel® @ Disable
@i~ Intel(R) Gigabit CT Desktop Adapt... | satus

Diagnose
'f;' Bridge Connections

Create Shortcut
Delete

=]
% Rename

"Ei' F’rop-er‘cite
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d. Uncheck ALL items/protocols for the network adapter.
e. Click “install” then choose “protocol” then click “add”.

U Panoramic Properties *
Networking  Sharing

Connect using:

I? Intel{R) Gigabit CT Desktop Adapter

" ion uses the following items:

QoS Packet Scheduler ~
Intemet Protocol Version 4 (TCP/IPv4)

Microsoft Metwork Adapter Muttiplexor Protocol

Microsoft LLDP Protocol Driver

Intemet Protocol Version & (TCP/IPvE)

Link-Layer Topology Discovery Responder

Link-Layer Topology Discovery Mapper /0 Driver Y]
>

~O00ogoood

Install... Uninstall Properties
sCription
Used to discover and locate other PCs, devices, and network

infrastructure components on the network. Also used to
detemmine network bandwidth.

oK Cancel

f. Click on the “Oy Ajat Ltd” and select the “SNAP GigE Driver”.

Note: If “Oy Ajat Ltd” is not listed, then you are missing critical Windows Updates.Click “OK” and then

“close” on the adapter properties.

Select Metwork Protocol ? bt

Click the Metwork Protocol that you want to install, then click OK. f you have
- an installation disk for this featurs, click Have Disk.

Manufacturer Network Protocal:
Microsoft B! SMAP GigE Driver

Oy Ajat ua\

=) This driver is digitally signed.
Tell me why driver signing is impartant

Have Disk...

Cancel

Note: It is Preferred to Uncheck SNAP GigE protocol from any of the other Network Interfaces listed,
especially any other INTEL or Broadcom brand interfaces

g. Rightclick on the Intel CT Desktop adapter again and go into the properties, and click the “configure” button
in the top right corner.
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h. Under the “Power Management” tab, uncheck all boxes.
i. Under the “advanced” tab change “Jumbo Packet” to a value of “9014”.

Teaming WVLANs Driver Details Events

General Link Speed Advanced Power Management

( |nter) Advanced Adapter Settings

Settings: Value:

Jumbo Packet 5014 Bytes v
Legacy Switch Compatibility Mode

Performance Cptions

Priority & VLAN

Uktra Low Power Mode

<

Use Default

j. Change the “Receive buffers” to a value of “2048".

If Receive buffers is not found, it might be found under Performance Options

k. Click “OK” to save your changes.

RESTART THE COMPUTER




OaNOramic

a. Open the “Panoramic Dental Imaging” software If prompted about Performance optimization click Yes.

Performance optimization

" _____,-'I hardware. The optimization process will take less than 30 seconds. Do

you want to perform the optimization now?

|® The performance of the software has not yet been optimized for this
-

b. Atthe top of the software click “Tools” then “Settings...”

¥ Panoramic Dental Imaging - [Unsaved dataset]
¥ File View Patient Image Tools Window Help

System status His Settings ...
Sengor Mot connected Dataset tools
Action  |dle 3
DICOM ...
Maintenance *
Mo zenzor connected! Send error report ..
Language >

c. Click on the “General” tab and select “Ask for patient information after exposure”.

Settings

Grabber] Panoramic unit] TWAIN] Imagel T

Fatient infarmatiar

" Mo patient information

I (* Ask for patient information after exposure

"~ Reguire patient information before exposure

d. Click on the “Grabber” tab and Ensure the proper preferred grabber is selected (INTEL gigabit CT desktop
adapter).

e. Click the “Panoramic unit” tab and chose your type of x-ray machine from the list. If you have the Intel NIC
card, chose the GLAN version of the machine.
PC1000 GLAN, PC4000 GLAN, Encompass, Envision P, or Envision C1

.

Settings

General | Grabber  Panoramic urit | TwiaiM | im

3 Panaoramic Corporation
i Encompass
i PC1000 Camera Link
- PC1000 GLAM
- PC4000 Camera Link
- PCA000 GLAM
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f. Click the “Image tab” and check the options of “Lower right corner” and “L and R markers”.

Settings &

General] Grabber] Panoramic unit] TwialM Tools ] Files and saving] DICOM ] Advanced]

Patient information imprinting | [~Image options

" None Iw Center image after exposure

Lawer left comer Mairitain image size in manual focusing window

< 7

(% Lower right carner L . .
I J I Maintain grey level in manual focusing window

(™ Bottom center

I Reset grey level settings when dataset changes
(e atiplineripling [ Crop non-radiated regions after exposure
" Mone . )
™ Show white border horizontal
I + L and R markers I
r

Show white border vertical

g. Click the “Files and saving” tab, and select “dataset”, set the “Max repository size” to “20000”, and the “Max
number of images” to “100” (these numbers can be adjusted to fit computer needs).

Settings EY
General] Grabber] Parioramic unit] Tl ] Image ] Toals DICOM ] Advanced]
[ ata repository uzage [ ata repository settings
" Mone |~ Remove backup image after save
™ Images anly Max repository size [ME] |2UUUU
Max number of images l'lﬂﬂi

h. Click “ok” on the settings windows to save your settings, if prompted to Reboot your PC, click “yes”.
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a. The calibration files should have been backed up from the previous computer. Copy all files in that folder to

the same location on the new PC.
C:\ProgramData\Ajat\panoramic\calib\
C:\ProgramData\Ajat\panoramic\datastor\

Note: This folder is created automatically after the software has been setup/configured. Make sure to

not copy the folder into itself. Example:

C:\ProgramData\Ajat\panoramic\calib\calib\ (wrong)

b. Power the X-ray machine Off, or ensure the sensor is powered off, wait 5 seconds, and power back On.

c. Verify GREEN CONNECTION status light in the TOP LEFT corner of the software program
800-654-2027 opt. 2 for the Service Dept.

Call Panoramic Support if problematic.

System status
Sensor Connected
Action  |dle (3]

System is ready

Important Note: If the calibration date is older than 2 years, please contact Technical Support or your Local Certified

Technician for recalibration. Panoramic Corporation strongly recommends Recalibration of the X-Ray unit & Software

every 2 years. If you cannot see the Date modified column, then you need to change the view of the folder to Details.

» ThisPC » O5(C:) » ProgramData » Ajat » pancramic » calib

~

Marme Date modified Type

|| calib_p_SNAP130-PC-0913-20.dat 12/9/2017 12:07 PM  DAT File 12,445 KB
|&] calib_p_SNAP150-PC-0913-20.dat.maske... 12/ PG File KB
|&] calib_p_SMAP150-PC-0913-20.dat.prema... 12/ PG File 2KB
| | calib_p_SMAP150-PC-0913-20.dat.temp 12/ TEMP File 12,445 KB
= calib_p_SNAP130-PC-0%13-20.dat.txt 12/ Text Document KB

View > Extra large icons
Sort by > Large icons
Group by > Medium icons
Refresh Small icons
Customize this folder... —

& Details
Paste Tiles
Paste shortcut Content
Undo Delete Ctrl+Z
Give access to b
MNew >

Properties
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a. Ensure the Software direction L/R (top right of screen) matches the Machine direction L/R (side panel)
Machines Encompass, Envision P, and Envision C1 are set to Automatic
A green connection to the software/sensor is required to change this button direction

PC1000 Camera Link "] Envision C1 [Z

Panoramic unit progran

Parnoramic unit program

. Automatic

a. Because this is a new computer the images by default will be very light until adjusted. You can follow the

instructions listed on page 20 of the Guide to getting the best images to adjust the default image
adjustments

How to Correct a VERY blurry images from image from using the wrong direction captured
Only for PC1000 & PC4000 units.

% Panocamic Dental imaging  (Unsaved datacet]

WL vier Pobars imoge [IREE] Window: o Reason for the Problem: The direction of the machine ? - = 2 - X
Sy Openimagefle_ | Settings | capture did not match the Software. Change the buttor ey |
Se  Opendataet. in the software by clicking on it, or change the machine o o
it direction to match. msaty| R oo SOl Uve NN
l [To Correct the image to avold a retake: Recover the
» :i::::.\, image by using the Data repository under the File { 4 ) Boosted mf::f.’.ﬂ Basc v[.,'f,?;.‘,r
ave iemageas AN menu. Once the poor image is reloaded, then flip the p— = =
A7 dataset direction by using the Tools menu.
'You may correct the image first if it is still on the screen

S N
O 10224 ves T2 SKLLL AATOM F i "

Repostory usage: 150 fles, 245/30000 megabytes.



http://www.pancorp.com/images/files/upload/FM_7453_Rev_A-PC4000_troubleshooting_and_Software_Guide.pdf

